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Document Conventions

The following table lists the text conventions that are used throughout this guide.

TABLE 1 Text Conventions

Convention Description Example
monospace Identifies command syntax examples device (config)# interface ethernet 1/1/6
bold User interface (Ul) components such On the Start menu, click All Programs.

as screen or page names, keyboard
keys, software buttons, and field
names

italics Publication titles Refer to the Ruckus Small Cell Release Notes for more information.

Notes, Cautions, and Safety Warnings

Notes, cautions, and warning statements may be used in this document. They are listed in the order of increasing severity of potential hazards.

NOTE
A NOTE provides a tip, guidance, or advice, emphasizes important information, or provides a reference to related information.

ATTENTION
An ATTENTION statement indicates some information that you must read before continuing with the current action or task.

CAUTION
A A CAUTION statement alerts you to situations that can be potentially hazardous to you or cause damage to hardware, firmware,
software, or data.

DANGER
A A DANGER statement indicates conditions or situations that can be potentially lethal or extremely hazardous to you. Safety labels are
also attached directly to products to warn of these conditions or situations.

Command Syntax Conventions

Bold and italic text identify command syntax components. Delimiters and operators define groupings of parameters and their logical relationships.

Convention Description

bold text Identifies command names, keywords, and command options.
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Document Feedback

Convention Description
italic text Identifies a variable.
[] Syntax components displayed within square brackets are optional.

Default responses to system prompts are enclosed in square brackets.

{x|y]|z} A choice of required parameters is enclosed in curly brackets separated by vertical bars. You must select one of the options.
x|y A vertical bar separates mutually exclusive elements.
<> Nonprinting characters, for example, passwords, are enclosed in angle brackets.

Repeat the previous element, for example, member[member...].

\ Indicates a “soft” line break in command examples. If a backslash separates two lines of a command input, enter the entire command at
the prompt without the backslash.

Document Feedback

RUCKUS is interested in improving its documentation and welcomes your comments and suggestions.
You can email your comments to RUCKUS at #Ruckus-Docs@commscope.com.

When contacting us, include the following information:
e  Document title and release number
] Document part number (on the cover page)
e Page number (if appropriate)
For example:
e  RUCKUS SmartZone Upgrade Guide, Release 5.0
e Part number: 800-71850-001 Rev A
e Page?

RUCKUS Product Documentation Resources

Visit the RUCKUS website to locate related documentation for your product and additional RUCKUS resources.

Release Notes and other user documentation are available at https://support.ruckuswireless.com/documents. You can locate the documentation by
product or perform a text search. Access to Release Notes requires an active support contract and a RUCKUS Support Portal user account. Other
technical documentation content is available without logging in to the RUCKUS Support Portal.

White papers, data sheets, and other product documentation are available at https://www.ruckuswireless.com.

Online Training Resources

To access a variety of online RUCKUS training modules, including free introductory courses to wireless networking essentials, site surveys, and
products, visit the RUCKUS Training Portal at https://training.ruckuswireless.com.
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Contacting RUCKUS Customer Services and Support

Contacting RUCKUS Customer Services and Support

The Customer Services and Support (CSS) organization is available to provide assistance to customers with active warranties on their RUCKUS
products, and customers and partners with active support contracts.

For product support information and details on contacting the Support Team, go directly to the RUCKUS Support Portal using https://

support.ruckuswireless.com, or go to https://www.ruckuswireless.com and select Support.

What Support Do | Need?

Technical issues are usually described in terms of priority (or severity). To determine if you need to call and open a case or access the self-service
resources, use the following criteria:

e  Priority 1 (P1)—Critical. Network or service is down and business is impacted. No known workaround. Go to the Open a Case section.

e  Priority 2 (P2)—High. Network or service is impacted, but not down. Business impact may be high. Workaround may be available. Go to
the Open a Case section.

e  Priority 3 (P3)—Medium. Network or service is moderately impacted, but most business remains functional. Go to the Self-Service
Resources section.

e  Priority 4 (P4)—Low. Requests for information, product documentation, or product enhancements. Go to the Self-Service Resources
section.

Open a Case

When your entire network is down (P1), or severely impacted (P2), call the appropriate telephone number listed below to get help:
e  Continental United States: 1-855-782-5871
e Canada: 1-855-782-5871

e  Europe, Middle East, Africa, Central and South America, and Asia Pacific, toll-free numbers are available at https://
support.ruckuswireless.com/contact-us and Live Chat is also available.

e Worldwide toll number for our support organization. Phone charges will apply: +1-650-265-0903

We suggest that you keep a physical note of the appropriate support number in case you have an entire network outage.

Self-Service Resources
The RUCKUS Support Portal at https://support.ruckuswireless.com offers a number of tools to help you to research and resolve problems with your
RUCKUS products, including:
e  Technical Documentation—https://support.ruckuswireless.com/documents
e Community Forums—https://forums.ruckuswireless.com/ruckuswireless/categories
e  Knowledge Base Articles—https://support.ruckuswireless.com/answers
e  Software Downloads and Release Notes—https://support.ruckuswireless.com/#products_grid
e  Security Bulletins—https://support.ruckuswireless.com/security
Using these resources will help you to resolve some issues, and will provide TAC with additional data from your troubleshooting analysis if you still

require assistance through a support case or RMA. If you still require help, open and manage your case at https://support.ruckuswireless.com/

case_management.

RUCKUS loT Controller Software Installation Guide , 1.5.0.1
Part Number: 800-72649-001 Rev A 7


https://support.ruckuswireless.com
https://support.ruckuswireless.com
https://www.ruckuswireless.com
https://support.ruckuswireless.com/contact-us
https://support.ruckuswireless.com/contact-us
https://support.ruckuswireless.com
https://support.ruckuswireless.com/documents
https://forums.ruckuswireless.com/ruckuswireless/categories
https://support.ruckuswireless.com/answers
https://support.ruckuswireless.com/#products_grid
https://support.ruckuswireless.com/security
https://support.ruckuswireless.com/case_management
https://support.ruckuswireless.com/case_management

RUCKUS loT Controller Software Installation Guide , 1.5.0.1
Part Number: 800-72649-001 Rev A



About This Guide
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Introduction to Ruckus loT Controller

The Ruckus IoT Controller is a versatile, easy-to-deploy service and management component that allows for integration of Internet of Things (loT)
devices and loT services for a wide range of use cases. It provides a robust, secure, scalable, interoperable, and well-managed general transport
between loT devices and cloud services.

The Ruckus loT Controller is an open-programmable framework that exposes northbound APIs and is thereby a highly flexible loT transport for
Ruckus partners to integrate a wide range of loT services and solutions for the enterprise and beyond.

This guide provides information about how to install the Ruckus |oT Controller on a supported hypervisor. Topics include the list of supported
hypervisors and Ruckus loT Controller installation instructions using the .OVA or .qcow? file.

NOTE
If release notes are shipped with your product and the information there differs from the information in this guide, follow the instructions

in the release notes.

This guide is intended for use by those responsible for installing and setting up network equipment. It assumes a basic working knowledge of local
area networking, wireless networking, and wireless devices.

RUCKUS IoT Controller Software Installation Guide , 1.5.0.1
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System Requirements for Installing Ruckus loT Controller
on a Hypervisor

Ruckus IoT Controller supports a number of hypervisors and requires a virtual machine (VM).

The following table lists the hypervisors (and their release versions) on which you can install the controller.

TABLE 2 Supported Hypervisors

Hypervisor Vendor Version

ESXi VMware 6.0 and later
VM VirtualBox Oracle 5.1.20 and later
VM Player VMware 12 or later
KvM Linux 2.11.1 or later

The virtual machine (VM) on which the controller is installed must meet the following requirements:
e The VM for the Oracle VM VirtualBox hypervisor must have a minimum of 4 vCPUs, 4 GB RAM, and 20 GB HDD.
e The VM for the VMware ESXi hypervisor must have a minimum of 4 vCPUs, 4 GB RAM, and 20 GB HDD.
e The VM for the VM Player hypervisor must have a minimum of 4 vCPUs, 4 GB RAM, and 20 GB HDD.
e The VM for the KVM hypervisor must have a minimum of 4 vCPUs, 4 GB RAM, and 20 GB HDD.
e Ports 80, 123 or NTP, 443, 1883, and 8883 must be open.

NOTE
For a high-scale deployment, Ruckus recommends a minimum of 8 vCPUs and 8 GB RAM.

Installing Ruckus loT Controller on Oracle VM VirtualBox

The Ruckus 10T Controller can be installed on an Oracle VM VirtualBox using an .OVA file.

NOTE
Ruckus loT Controller can be installed on a Mac or a Windows 64-bit machine.

RUCKUS loT Controller Software Installation Guide , 1.5.0.1
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Installing Ruckus loT Controller on a Hypervisor
Installing Ruckus 10T Controller on Oracle VM VirtualBox

Complete the following steps to install Ruckus IoT Controller on a Mac.

1. Download the Ruckus loT Controller distribution package in the .OVA file format from the Ruckus Support website at https://
support.ruckuswireless.com.

2. Open the Oracle VM VirtualBox Manager and select File > Import Appliance.
FIGURE 1 Oracle VM VirtualBox Manager

& VirtualBox Iaa Machine Window Help © Q = 7% @ Thu3:45PM Shriram Q =

[ NON J Import Appliance... %8l Oracle VM VirtualBox Manager
2»' - Export Appliance... $E 03 fHﬂ
ng | Virtual Media Manager... %D =] Details []ﬂ 5

- v v
New ¢ Host Network Manager... 3#W Machine Tools Global Tools

Welcome to VirtualBox!

The left part of this window lists all virtual machines and virtual machine groups on your computer. The list is empty
now because you haven't created any virtual machines yet.

In order to create a new virtual machine, press the New button in the main tool bar located at the top of the window.

You can press the 88? key to get instant help, or visit www.virtualbox.org for more information and latest news.

The installation begins.

RUCKUS loT Controller Software Installation Guide , 1.5.0.1
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Installing Ruckus loT Controller on a Hypervisor
Installing Ruckus IoT Controller on Oracle VM VirtualBox

3. Import the .OVA file of the virtual appliance and click Continue.

FIGURE 2 Importing the Virtual Appliance

Appliance to import
VirtualBox currently supports importing appliances saved in the Open Virtualization Format (OVF). To
continue, select the file to import below.

JUsers/Downloads/vriot-1.5.0.0.21.0va ' d

Expert Mode Go Back Continue Cancel
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Installing Ruckus 10T Controller on Oracle VM VirtualBox

4. Confirm the appliance settings and click Import.

FIGURE 3 Importing the Appliance Settings

Al
I L

%iwﬁ

New

14

Oracle VM VirtualBox Manager

2ol

v v|
Machine Tools Global Tools
Appliance settings
These are the virtual machines contained in the appliance and the
suggested settings of the imported VirtualBox machines. You can
change many of the properties shown by double-clicking on the items
and disable others using the check boxes below. 5
Virtual System 1 r
%2 Name Ruckus loT Controller
E Guest OS Type Ubuntu (84-bit)
{} CPU 2
# RAM 2048 MB
i’ Network Adapter v| Intel PRO/1000 MT Serv...
<> Storage Controller (IDE) PlIX4
Reinitialize the MAC address of all network cards
Appliance is not signed
—
Restore Defaults Go Back Import Cancel [
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Installing Ruckus loT Controller on a Hypervisor
Installing Ruckus IoT Controller on Oracle VM VirtualBox

5. Accept the terms of the license agreement and click Agree.

FIGURE 4 License Agreement

The virtual system "Ruckus loT Controller"
requires that you agree to the terms and conditions
of the software license agreement shown below.

Click Agree to continue or click Disagree to cancel
the import. i

i |

RUCKUS WIRELESS, INC.

Ruckus loT Controller (RloT Controller) Software i
License

PLEASE READ THIS SOFTWARE LICENSE
CAREFULLY. RUCKUS WIRELESS, INC.
("RUCKUS") IS WILLING TO LICENSE THE
SOFTWARE

TO YOU ("LICENSEE") ONLY ON THE /
CONNITION THAT THF | ICFNSFF ACCEPRTS Al |

Print... Save... Disagree Agree

When the import has completed, the Ruckus IoT Controller .OVA file runs in VirtualBox.
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FIGURE 5 Ruckus loT Controller .OVA File Running in VirtualBox

Oracle VM VirtualBox Manager

i}{%} . > . Ul

¥ ¥
ew Settings Discart Show Machine Tools Global Tools
Puokugfal Soatnaiat Welcome to VirtualBox!
, L Running &

The left part of this window lists all
virtual machines and virtual machine
groups on your computer.

The right part of this window

represents a set of toocls which are

currently opened (or can be opened)

for the currently chosen machine. For ’

a list of currently available tools check
the corresponding menu at the right
side of the main tool bar located at the
top of the window. This list will be
extended with new tools in future
releases,

You can press the 3#87? key to get
instant help, or visit

www. virtualbox.org for more
information and latest news.

6. Select Bridged Adapter to configure the VirtualBox interfaces.
FIGURE 6 VM Interface Configuration

vriot - Network

QEQ@EFI@E =

General System Display Storage Audio Network Ports Shared Folders User Interface

Adapter 2 Adapter 3 Adapter 4

Enable Network Adapter

System

Attached to:  Bridged Adapter E

Mame: en7: Apple USB Ethernet Adapter E
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Installing Ruckus loT Controller on Oracle VM VirtualBox

7. Power on the virtual machine and wait for the login prompt.

The Ruckus loT Controller login prompt is displayed.

FIGURE 7 Ruckus loT Controller Login Prompt

Ruckus loT Controller [Running]

[Ruckus IoT Controller

8. Enter the username and the password at the login prompt.
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9. Enter 1in the Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the Ruckus IoT Controller Initialization page.

FIGURE 8 Displaying the IP Address

To configure N+1 on the Ruckus IoT Controller, enter 5 in the Enter Choice field. Refer to "Configuring N+1" in the Ruckus loT Controller
Configuration Guide to complete this configuration.
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10. Open a web browser on your host machine and enter the IP address of the VM in the address bar.

HTTP and HTTPS on ports 80 and 443 are supported.

The Initialization page is displayed.

FIGURE 9 Intialization Page

THRUCKUS loT Controller  leT 4R

Initialization

Click on next button to continue

11. Select the required services and click Next.
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12. Confirm the configuration information and click Next.

FIGURE 10 Initial VM and IP Configurations

'ﬁnucws‘ laT €

Initialization

k on next button to continue

America/Los_Argedes -

Set Time Automatically using NTP @ Set Time Manually i

NTP Address (@ptional)

The Ruckus loT Controller Initialization page is displayed.

FIGURE 11 Confirming the Password

.ﬁRUCKUS' loT Controller  1eTAPI

Initialization

Enter new password to continue

MNew Password

i

Confirm Password

13. Enter a new password and re-enter the new password in the Confirm Password field. Click Start.
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14. The End-user License Agreement page is displayed. Click Accept to accept the Ruckus loT Controller license.

FIGURE 12 End-user License Agreement Page

End-user License Agreement

Ruckus loT Controller (RloT Contraller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INC. ("RUCKUS") IS WILLING TO LICENSE THE SOFTWARE TO YOU
{"LICENSEE") OHLY OM THE COMDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS AMD CONDITIONS. IF A USER
ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPLOYEE OF, OR AS AN AGENT OR CONTRACTOR
FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED THE LICENSEE AND THE USER REPRESENTS THAT IT HAS THE
POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT QN BEHALF OF THE COMPANY, BY DOWMLDADING, INSTALLING AND/OR USING
THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS LICENSE AND AGREES TO BE BOUND BY |T5 TERMS AND CONDITIONS.
IF LICENSEE DOES NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENSE, RUCKUS IS UNWILLING TO LICENSE THE SOFTWARE. IN
THAT EVENT, LICENSEE MAY NOT DOWNLOAD, USE OR INSTALL THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICENSE
FEES ACTUALLY PAID FOR THE SOFTWARE,

1) Definitions

“Device” means a single Ruckus access point on Licensees network. “Documentation” means the published technical manals, including any

updates thereto, relating to the use of the Software made generally available by Ruckus. "Evaluation Term™ means the limited period of time
Licensee's initial of the Software during which Licensee is permitted to use the Software without placing an Order;

provided, that the Evaluation Term is subject to early termination as provided in this agreement. “Software”™ means a copy of a machine
executable version of a Ruckus softwane preduct that Ruckus makes available to Licensee for downlead onte equipment ewned or controlled
by Licensee, and any error corrections, updates or upgrades of such software product that Ruckus makes available to Licersee. "Order”
means one o maore erdering documents. or transactional records in the form required by Ruckus from Licensee (or a Ruckus Channel Partner
for the benefit of Licensee) to activate the Software or increase the Authorized Device Limit, "Ruckus Channel Partner” means an entity

Close ‘ [ Accept

You are ready to configure and start the Ruckus |oT Controller services. Refer to the Ruckus loT Controller Configuration Guide for more information.

Installing Ruckus loT Controller on a VMware ESXi

The Ruckus IoT Controller can be installed on a VMware ESXi hypervisor using an .OVA file.

1. Download the Ruckus loT Controller distribution package in the .OVA file format from the Ruckus Support website at https://
support.ruckuswireless.com.
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2.  Open VMware ESXi and select Virtual Machines from the Navigator pane.

FIGURE 13 Creating or Registering Virtual Machines

vmware ESXi"

SR NN RN Q Search

“I% Navigator (41 localhost.video54.local - Virtual Machines
~ [ Host
Manage ﬁl Create / Register VM Console Poweron @ Powe ) Suspen ‘ e Refresh ‘ Ac Q Search
Monitor Virtual macl Create or register a virtual machine v Status ~ Used space ~  Guest 0S ~ Host name ~ HostCPU ~ Host memory v
#* Virtual Machines . (51 Automation-ubuntu-16.04-installer ° Nor... 14.18GB Ubuntu Linux (64-bit) Unknown 0 MHz o0MB
E storage | {51 Automation-Stage-Server @ Nor... 11.55GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
Q Networking "~ {51 Automation-Production-Server @ Nor... 15.48GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
"~ 51 Gateway-Vriot @ Nor... 7.72GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
~ {51 IBM-Vriot-1.3.0.0.1 Q Nor... 5.61GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
& QA-visionline @ Nor... 17.27GB Microsoft Windows Se...  Unknown 18 MHz 6.02 GB
~) % ga-win-dns-200 @ Nor... 11.52GB Microsoft Windows Se...  Unknown 25 MHz 3.93 GB
51 Gateway-vsz-10019 @ Nor... 29.85GB Other (32-bit) Unknown 0 MHz 0MB
17items
Recent tasks |
Task ~  Target ~ | Initiator ~ | Queued v  Started ~  Result ~  Completed v v

3. Click Create/Register VM.
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4. Onthe New virtual machine page, click Select creation type, and select Deploy a virtual machine from an OVF or OVA file. Click Next.

FIGURE 14 Select Creation Type Page

?ﬂ] New virtual machine

2 Select OVF and VMDK files

vEEEEEEXTHED  Select creation type

How would you like to create a Virtual Machine?

3 Select storage

4 License agreements

5 Deployment options
6 Additional settin:

Create a new virtual machine

Register an existing virtual machine

Deploy a virtual machine from an OVF or OVA file

This option guides you through the process of creating a
virtual machine from an OVF and VMDK files.

Back Next Finish
-,
5. Click Select OVF and VMDK files, enter a name for the virtual machine, and select the OVF file. Click Next.
FIGURE 15 Select OVF and VMDK Files Page
51 New virtual machine - VRIOT
+ 1 Belect creation type Select OVF and VMDK files
Select the OVF and VMDK files or OVA for the VM you would lke to deplay
3 Select storage
‘umm Enter a name for the virtual machine.
5 Depleyment options T 1
& Additional settings | veaT |
7 Ready to complete Virtual machine names can contain up to 80 characters and they must be unique within each ESXI instance.
» (BB vriot-xx x.x.ova
ook || tew || Foen [ coel |
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6. Click Select storage, and select the datastore in which you want to save the configuration and disk files. Click Next.

FIGURE 16 Select Storage Page

741 New virtual machine - [oT - IoT

¥ 1 Select creation type Select storage
+ 2 Select OVF and VMDK files

Select the datastore in which to store the configuration and disk files

bd 3 Select storage

v
o Lo s agraspmnts The following datastores are accessible frem the destination resource that you selected. Select the destinabon datastore for the

+ § Deployment options virtual machine configuration files and all of the virtual disks.

& Ready to complete
Name v | Capacity w | Free v  Type v Thinpro... v | Access e
datastore1 924 GB B07.09 GB VMFS6 Supported Single

1 items

| Back | Finish Cancel
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7. Click License agreements to accept the terms and conditions of the software license and click Agree.

FIGURE 17 License Agreements Page

741 New virtual machine - loT - loT

¥ 1 Select creation type License agreements

¥ 2 Select OVF and VMDK files Read and accept the license agreements

v 3 Select storage

M Loensesoreemens S

+ 5 Deployment options
& Ready to complete

RUCKUS WIRELESS, INC.
Ruckus IoT Controller {RIoT Controller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INMC. ("RUCKUS™) IS WILLING TO LICE
TO ¥OU (“LICEMSEE") OMLY ON THE COMNDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS ARk
IF A USER ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPLOWEE OF, C
Of COWTRACTOR FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED THE LICENSEE AND THE U2
THAT IT HAS THE POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT ON BEHALF OF THE COMPANMY .

BY DOWNLOADING, IMSTALLING AND/OR USING THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIZ
AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. IF LICENSEE DOES MOT AGREE TO THE TERMS AND CONC
LICENSE, RUCKUS IS UNWILLING TQ LICENSE THE SOFTWARE. 1IN THAT EVENT, LICENSEE MAY HOT DOWNLOAD,
THE SOFTHARE AND SHALL BE GIVEM A FULL REFUND OF ANY LICENSE FEES ACTUALLY PALD FOR THE SOFTWARE.

1) Definitions
“Device" means a single Ruckus access point on Licenses’s network.
“Documentation” means the published technical manuals, including any updates therato, relating tc
avallable by Ruckus.
"evaluation Term™ means the limited period of time following Licensee’s initial download of the
to use the Software without placing an Order; provided, that the Evaluation Term is subject to e:

Lomee |

Cancel |

oo ]

e
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8.

Click Deployment options, and select the Network mappings and Disk provisioning. Click Next.

FIGURE 18 Deployment Options Page

%91 New virtual machine - 1T - IoT

" 1 Select creation type
+ 2 Select OVF and VMDK files
+ 3 Select storage

' 4 License agreements

bd 5 Deployment options

6 Ready to complete

Deployment options

Select deployment ophons

Metwork mappings VM Netwark | Wi Network
Disk provisioning & Thin & Thick
Power on automatically L4

Back | Finizh Cancel

4
!
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9. Click Ready to complete and review the settings. Click Finish.

FIGURE 19 Ready to Complete Page

4 New virtual machine - VRIOT

¥ 1 Select creation type Ready to complete
+' 2 Select OVF and VMDK files
+ 3 Select storage

v 4 License agreements

Review your settings selection before finishing the wizard

+' 5 Deployment options Al i

s oty o compers—— JPRRTN vror
Disks vriot-1.5.0.0.21.vmadk
Datastore datastorel
Provisioning type Thin
Network mappings VM Network: VM Network
Guest OS Name Unknown

! 2 Do not refresh your browser while this VM is being deployed.

| Back || mex || Fnisn || cancel |

The Ruckus loT Controller login prompt is displayed.
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FIGURE 20 Ruckus loT Controller Login Prompt

Ruckus loT Caontroller [Running]

[Ruckus IoT Controller

10. Log in to the virtual machine using the username and password.
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11. Enter 1in the Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the Ruckus IoT Controller Initialization page.

FIGURE 21 Displaying the IP Address

To configure N+1 on the Ruckus IoT Controller, enter 5 in the Enter Choice field. Refer to "Configuring N+1" in the Ruckus loT Controller
Configuration Guide to complete this configuration.
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12. Open a web browser on your host machine and enter the IP address of the VM in the address bar.

HTTP and HTTPS on ports 80 and 443 are supported.

The Initialization page is displayed.

FIGURE 22 Intialization Page

THRUCKUS loT Controller  leT 4R

Initialization

Click on next button to continue

13. Select the required services and click Next.
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14. Confirm the configuration information and click Next.

FIGURE 23 Initial VM and IP Configurations

TRUCKUS loT Controller  IoT AR

AmericaiLos_Argeles

Initialization

Click on next button to conti

DHCP @ Static

Set Time Automatically using NTP @ Sot Time Manually i

NTP Address (Optional)

The Ruckus loT Controller Initialization page is displayed.

FIGURE 24 Confirming the Password

1.5

ontroller 1T API . S
Americallos_Angeles

Initialization

Enter new password to continue

MNew Passwaord

Confirm Password

i

15. Enter a new password and re-enter the new password in the Confirm Password field. Click Start.
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16. The End-user License Agreement page is displayed. Click Accept to accept the Ruckus loT Controller license.

FIGURE 25 End-user License Agreement Page

End-user License Agreement

Ruckus loT Controller (RloT Contraller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INC. ("RUCKUS") IS WILLING TO LICENSE THE SOFTWARE TO YOU
{"LICENSEE") OHLY OM THE COMDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS AMD CONDITIONS. IF A USER
ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPLOYEE OF, OR AS AN AGENT OR CONTRACTOR
FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED THE LICENSEE AND THE USER REPRESENTS THAT IT HAS THE
POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT QN BEHALF OF THE COMPANY, BY DOWMLDADING, INSTALLING AND/OR USING
THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS LICENSE AND AGREES TO BE BOUND BY |T5 TERMS AND CONDITIONS.
IF LICENSEE DOES NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENSE, RUCKUS IS UNWILLING TO LICENSE THE SOFTWARE. IN
THAT EVENT, LICENSEE MAY NOT DOWNLOAD, USE OR INSTALL THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICENSE
FEES ACTUALLY PAID FOR THE SOFTWARE,

1) Definitions

“Device” means a single Ruckus access point on Licensees network. “Documentation” means the published technical manals, including any

updates thereto, relating to the use of the Software made generally available by Ruckus. "Evaluation Term™ means the limited period of time
Licensee's initial of the Software during which Licensee is permitted to use the Software without placing an Order;

provided, that the Evaluation Term is subject to early termination as provided in this agreement. “Software”™ means a copy of a machine
executable version of a Ruckus softwane preduct that Ruckus makes available to Licensee for downlead onte equipment ewned or controlled
by Licensee, and any error corrections, updates or upgrades of such software product that Ruckus makes available to Licersee. "Order”
means one o maore erdering documents. or transactional records in the form required by Ruckus from Licensee (or a Ruckus Channel Partner
for the benefit of Licensee) to activate the Software or increase the Authorized Device Limit, "Ruckus Channel Partner” means an entity

Close ‘ [ Accept

You are ready to configure and start the Ruckus |oT Controller services. Refer to the Ruckus loT Controller Configuration Guide for more information.

Installing Ruckus loT Controller Using VMware Player

The Ruckus loT Controller can be installed on a virtual machine using VMware Player.

32

1.

2.

Download the Ruckus loT Controller distribution package in the .OVA file format from the Ruckus Support website at https://

support.ruckuswireless.com.

Open VMware Player.
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3.  From the Player menu, select File > Open, and select the .OVA file for the Ruckus IoT Controller.

FIGURE 26 Selecting the .OVA File

| > - o B T
File » (2] New Virtual Machire...
Power Open...

Femovable Devices
Send Ctrl+Alt+Del
Manage

1 Full Screen
Unity

Ctrl+ Al +Enter

Help »

Exit

Download Virtual Appliance

Preferences...

Ctrl+M

0 Jare

layer

The installation begins.
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Create a New Virtual Machine

Create a new virtual machine, which will then be added to
the top of your library.

Open a Virtual Machine

Open an existing virbual machine, which will then be added
to the top of your library.

Upgrade to VMware Workstation Pro

Get advanced features such as snapshots, virtual network
management, and maore.

Help

View online help.
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4.  Accept the terms of the end user license agreement and click Next.

FIGURE 27 End User License Agreement

_
I

Player ¥ .

Import Virtual Machine

End User License Agreement

Accept the end user license agreements.

RUCKUS WIRELESS, INC.

1) Definitions

available by Ruckus.

Ruckus IoT Controller (RIoT Controller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRE
TO YOU ("LICENSEE") ONLY ON THE CONDITION THAT THE LICENS
IF A USER ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INS™
OR CONTRACTOR FOR THE BENEFIT OF, A COMPANY, THAT COMP/
THAT IT HAS THE POWER AND AUTHORITY TO ACCEPT THIS AGRE
BY DOWNLOADING, INSTALLING AND/OR USING THE SOFTWARE, L
AGREES TO BE BOUND BY ITS TERMS AND COMDITIONS. IF LICENS
LICENSE, RUCKUS IS UNWILLING TO LICENSE THE SOFTWARE. IN ™
THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICE

"Device" means a single Ruckus access point on Licensee's network.
"Documentation” means the published technical manuals, including any

EI accept the terms of the license agreement.

Help
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5. Enter a name and storage path for the virtual machine and click Import.

FIGURE 28 Naming the Virtual Machine

| .
| Player ~ B 1
i

Import Virtual Machine

Store the new Virtual Machine
Provide a name and local storage path for the new virtual machine.

Name for the new virtual machine:

| RIoT Controller

Storage path for the new virtual machine:

| C:\Users\test\Documents\Virtual Machines\RIoT Controller Browse. ..

< Back Cancel

VMware Player begins importing the Ruckus loT Controller.
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FIGURE 29 Importing the Ruckus loT Controller

Player ~ B I

Importing RloT Controller

Importing RIoT Controller
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6. Login to the Ruckus IoT Controller using the username and password.

FIGURE 30 Ruckus loT Controller Login Prompt

Ruckus IoT Controller

uriot login: _
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38

7.

From the Player menu, select Manage > Virtual Machine Settings to open the settings for the virtual machine.

FIGURE 31 Opening the Virtual Machine Settings

Player ¥ = 'ﬁjr‘ B T h
File >

Q) Power >

( | Removable Devices >

£TL' Send Ctrl+Alt+Del

X\ Manage ? Reinstall VMware Tools

TT Full Screen Ctrl+Alt+Enter |7 Message Log

D._] Unity 'JJ::—'_LI Virtual Machine Settings... Ctrl+D
Help >
Exit
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8. Click the Bridged network connection and select the appropriate host network adapter for automatic bridging. Click OK.

FIGURE 32 Virtual Machine Settings Page

Hardware Options

Device Summary
B8 Memory 2 GB
[ Processors 2
et Hard Disk (SCSI) 8 GB
@Netwurk Adapter Bridged (Automatic)
EDisplayr 1 monitor
Automatic Bridging Settings X

Select the host network adapter(s) you want to automatically
bridge:

D ASIX AX88179 USB 3.0 to Gigabit Ethernet Adapter #2
[ ]PANGP Virtual Ethernet Adapter

[ |Microsoft Wi-Fi Direct Virtual Adapter

[ |Bluetooth Device (Personal Area Network)

[ intel(R) Dual Band Wireless-AC 8260

Intel(R) Ethernet Connection 1219-LM

DJuniper Network Connect Virtual Adapter

[ virtualBox Host-Only Ethernet Adapter

Device status
Connected
Connect at power on ,

Network connection
@ Bridged: Connected directly to the physical network

D Replicate physical network connection state
. Configure Adapters

(C)NAT: Used to share the host's IP address
(_)Host-only: A private network shared with the host
() Custom: Spedific virtual network

VMnet0 (Auto-bridging)
() LAN segment:

LAN Segments.... Advanced... .

Add... Remove
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9. Inthe Ruckus loT Controller Main Menu, enter 4 in the Enter Choice field to perform system operation on the Ruckus loT Controller. To
restart the system, enter 1. To reboot the system, enter 2 in the Enter Choice field.

FIGURE 33 Rebooting Ruckus loT Controller

RUCKUS loT Controller Software Installation Guide , 1.5.0.1
40 Part Number: 800-72649-001 Rev A



Installing Ruckus loT Controller on a Hypervisor
Installing Ruckus 10T Controller Using VMware Player

10. Enter 1in the Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the Ruckus IoT Controller Initialization page.

FIGURE 34 Displaying the IP Address

To configure N+1 on the Ruckus IoT Controller, enter 5 in the Enter Choice field. Refer to "Configuring N+1" in the Ruckus loT Controller
Configuration Guide to complete this configuration.
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11. Open a web browser on your host machine and enter the IP address of the VM in the address bar.

HTTP and HTTPS on ports 80 and 443 are supported.

The Initialization page is displayed.

FIGURE 35 Intialization Page

THRUCKUS loT Controller  leT 4R

Initialization

Click on next button to continue

12. Select the required services and click Next.
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13. Confirm the configuration information and click Next.

FIGURE 36 Initial VM and IP Configurations

TRUCKUS loT Controller  IoT AR

AmericaiLos_Argeles

Initialization

Click on next button to conti

DHCP @ Static

Set Time Automatically using NTP @ Sot Time Manually i

NTP Address (Optional)

The Ruckus loT Controller Initialization page is displayed.

FIGURE 37 Confirming the Password

'ﬁnucms‘ loT Contraller  loTAPI

Initialization

Enter new password to continue

MNew Passwaord

Confirm Password

i

14. Enter a new password and re-enter the new password in the Confirm Password field. Click Start.
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15. The End-user License Agreement page is displayed. Click Accept to accept the Ruckus loT Controller license.

FIGURE 38 End-user License Agreement Page

End-user License Agreement

Ruckus loT Controller (RloT Contraller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INC. ("RUCKUS") IS WILLING TO LICENSE THE SOFTWARE TO YOU
{"LICENSEE") OHLY OM THE COMDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS AMD CONDITIONS. IF A USER
ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPLOYEE OF, OR AS AN AGENT OR CONTRACTOR
FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED THE LICENSEE AND THE USER REPRESENTS THAT IT HAS THE
POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT QN BEHALF OF THE COMPANY, BY DOWMLDADING, INSTALLING AND/OR USING
THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS LICENSE AND AGREES TO BE BOUND BY |T5 TERMS AND CONDITIONS.
IF LICENSEE DOES NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENSE, RUCKUS IS UNWILLING TO LICENSE THE SOFTWARE. IN
THAT EVENT, LICENSEE MAY NOT DOWNLOAD, USE OR INSTALL THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICENSE
FEES ACTUALLY PAID FOR THE SOFTWARE,

1) Definitions

“Device” means a single Ruckus access point on Licensees network. “Documentation” means the published technical manals, including any

updates thereto, relating to the use of the Software made generally available by Ruckus. "Evaluation Term™ means the limited period of time
Licensee's initial of the Software during which Licensee is permitted to use the Software without placing an Order;

provided, that the Evaluation Term is subject to early termination as provided in this agreement. “Software”™ means a copy of a machine
executable versien of a Ruckus software product that Ruckus makes available to Licensee for download onto equipment owned or controlled
by Licensee, and any error corrections, updates or upgrades of such software product that Ruckus makes available to Licersee. "Order”
means one o maore erdering documents. or transactional records in the form required by Ruckus from Licensee (or a Ruckus Channel Partner
for the benefit of Licensee) to activate the Software or increase the Authorized Device Limit, "Ruckus Channel Partner” means an entity

Close i

[ accept |

You are ready to configure and start the Ruckus |oT Controller services. Refer to the Ruckus loT Controller Configuration Guide for more information.

Installing a KVM Guest Using virsh Commands

The Ruckus loT Controller can be installed on the KVM Guest using virsh commands.
1. Use the tar -xvf vriot-qcow2-1.5.0.0.x.tar command to extract the vriot-qcow2-1.5.0.0.x.tar file.
2. Use the sudo mv vriot-1.5.0.0.x.qcow2 /var/lib/libvirt/images/ command to move the gqcow2 image to the libvirt images path..
3. Use the virsh define vriot-1.5.0.0.x.xml command to define the VM.

NOTE
You must edit the XML file to add it to the network interface

4. Use the virsh start Ruckus-loT-Controller command to start the virtual machine (VM)..

5. Use the virsh console Ruckus-loT-Controller command to obtain console access to the VM..

Installing a KVM Guest Using Virtual Machine Manager

The Ruckus IoT Controller can be installed on a KVM guest using Virtual Machine Manager.

1. Download the Ruckus loT Controller distribution package in the .tar file format from the Ruckus Support website at https://
support.ruckuswireless.com.

2. Use the tar -xvf filename.tar command to obtain the gcow2 image file and template file.

3. Open the Virtual Machine Manager.
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Installing a KVM Guest Using Virtual Machine Manager

4.  From the Virtual Machine Manager menu, select File > Create a New Virtual Machine.

FIGURE 39 Virtual Machine Manager Menu

Virtual Machine Manager

File Edit View Help

|E| Oper
Name 2  (CPU usage
localhost (QEMLU)

The New VM dialog box is displayed.
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5. Enter the name of the virtual machine, select Import existing disk image, and click Forward.

FIGURE 40 New VM Dialog Box Step 1

File Edit View Help

New VM

m Create a new virtual machine

Enter your virtual machine details
Name: |VRIOT-KVM
Connection: localhost (QEMU/KVM)

Choose how you would like to install the operating system
() Local install media (15O image or CDROM)
) Network Install (HTTP, FTP, or NFS)
) Metwork Boot (PXE)

@® Import existing disk image

Cancel Back Forward
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6. Enter the path of the .qcow image, the operating system type, and the version number, and click Forward.

FIGURE 41 New VM Dialog Box Step 2

New VM
m Create a new virtual machine

Provide the existing storage path:

,f’h0me,f’vriot—qa—z,f’[)esktopfwiot—BB?a.offline—upgf

Choose an operating system type and version

OS type: | Generic =

Version: | Generic

Cancel Back

| Browse...

Forward
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7. Select the memory size of RAM (in MB) and the number of central processing units (CPUs) for the virtual machine, and click Forward.

FIGURE 42 New VM Dialog Box Step 3

File Edit View Help

New VM
m Create a new virtual machine

Choose Memory and CPU settings
Memory (RAM): | 4096 . MB
Up to 15929 MB available on the host

CPUs: 4.,
Up to 4 available

Cancel Back Forward
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8. Select Customize configuration before install, and click Finish.

FIGURE 43 New VM Dialog Box Step 4

New VM

E Create a new virtual machine

Ready to begin installation of VRIOT-KVM
0S: Generic
Install: Import existing OS image
Memory: 4096 MB
CPUs: 4
Storage: 1.2 GB fhome/vriot-qa-2/Desktop/vriot-937a.offline-upgrade....

[ Customize configuration before install
0 Specifying an operating system is required For best performance

P Advanced options

Cancel Back Finish

The Ruckus loT Controller installation on the virtual manager begins.
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Installing a KVM Guest Using Virtual Machine Manager

9. After the installation has completed, open the Virtual Machine Manager. Select Disk in the left pane and information about the disk is
displayed. Expand Advanced options and ensure that the disk bus is IDE and the storage format is qcow2.

FIGURE 44 Virtual Disk Configuration

VRIOT-KVM Virtual Machine .

Overview

Processor

e

Memory

Boot Options
Disk 1
NIC:27:3e:10
Input

Display VNC
Sound: default

Console
Video Default

l 4.} [«

Add Hardware

o Begininstallation 3 cancel

Virtual Disk
Target device: Disk 1

Source path: /home/fvriot-qa-2/Desktop/vriot-937a.offline-upgrade.3070.qcow2

Storage size; 1.18GB
Readonly: [
Shareable:

¥ Advanced options
Disk bus: | IDE &
Serial number:

Storage Format: | qcow2 v

P Performance options
10 Tuning

(7] Tip: 'source’ refers to information seen from the host OS,
while "target' refers to information seen from the guest 05

Remove Cancel

Apply
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10. Select Boot Options in the left pane. Ensure that Start virtual machine on host boot up and Enable boot menu are selected. Select Hard

Disk and click Apply.

FIGURE 45 Boot Options Configuration

VRIOT-KVM Virtual Machine m

«// Begin Installation ecancel

W

o fail

L [ZY &

Overview
Processor
Memory
Boot Options
IDE Disk 1

NIC :27:3e:10
Input

Display VNC
Sound: default
Console
Video Default

Add Hardware

Installing Ruckus loT Controller on a Hypervisor
Installing a KVM Guest Using Virtual Machine Manager

Autostart
Start virtual machine on host boot up

Boot device order
Enable boot menu

]

H

P Direct kernel boot

Cancel

Apply
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11. Login to the Ruckus loT Controller using the username and password.

FIGURE 46 Ruckus loT Controller Login Prompt

VRIOT-KVM Virtual Machine

File Virtual Machine View SendKey

ot login: _
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12. Enter 1in the Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the Ruckus IoT Controller Initialization page.

FIGURE 47 Displaying the IP Address

To configure N+1 on the Ruckus IoT Controller, enter 5 in the Enter Choice field. Refer to "Configuring N+1" in the Ruckus loT Controller
Configuration Guide to complete this configuration.
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13. Open a web browser on your host machine and enter the IP address of the VM in the address bar.

HTTP and HTTPS on ports 80 and 443 are supported.

The Initialization page is displayed.

FIGURE 48 Intialization Page

THRUCKUS loT Controller  leT 4R

Initialization

Click on next button to continue

14. Select the required services and click Next.
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15. Confirm the configuration information and click Next.

FIGURE 49 Initial VM and IP Configurations

'ﬁnucws‘ laT €

Initialization

k on next button to continue

America/Los_Argedes -

Set Time Automatically using NTP @ Set Time Manually i

NTP Address (@ptional)

The Ruckus loT Controller Initialization page is displayed.

FIGURE 50 Confirming the Password

.ﬁRUCKUS' loT Controller  1eTAPI

Initialization

Enter new password to continue

MNew Password

i

Confirm Password

16. Enter a new password and re-enter the new password in the Confirm Password field. Click Start.
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17. The End-user License Agreement page is displayed. Click Accept to accept the Ruckus loT Controller license.

FIGURE 51 End-user License Agreement Page

End-user License Agreement

Ruckus loT Controller (RloT Contraller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INC. ("RUCKUS") IS WILLING TO LICENSE THE SOFTWARE TO YOU
{"LICENSEE") OHLY OM THE COMDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS AMD CONDITIONS. IF A USER
ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPLOYEE OF, OR AS AN AGENT OR CONTRACTOR
FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED THE LICENSEE AND THE USER REPRESENTS THAT IT HAS THE
POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT QN BEHALF OF THE COMPANY, BY DOWMLDADING, INSTALLING AND/OR USING
THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS LICENSE AND AGREES TO BE BOUND BY |T5 TERMS AND CONDITIONS.
IF LICENSEE DOES NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENSE, RUCKUS IS UNWILLING TO LICENSE THE SOFTWARE. IN
THAT EVENT, LICENSEE MAY NOT DOWNLOAD, USE OR INSTALL THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICENSE
FEES ACTUALLY PAID FOR THE SOFTWARE,

1) Definitions
“Device” means a single Ruckus access point on Licensees network. “Documentation” means the published technical manals, including any
updates thereto, relating to the use of the Software made generally available by Ruckus. "Evaluation Term™ means the limited period of time
Licensee's initial of the Software during which Licensee is permitted to use the Software without placing an Order;
provided, that the Evaluation Term is subject to carly termination as provided in this agreement. “Software” means a copy of a maching
executable versien of a Ruckus software product that Ruckus makes available to Licensee for download onto equipment owned or controlled
by Licensee, and any error corrections, updates or upgrades of such software product that Ruckus makes available to Licersee. "Order”
means one o maore erdering documents. or transactional records in the form required by Ruckus from Licensee (or a Ruckus Channel Partner
for the benefit of Licensee) to activate the Software or increase the Authorized Device Limit, "Ruckus Channel Partner” means an entity

Close ‘ [ Accept

You are ready to configure and start the Ruckus |oT Controller services. Refer to the Ruckus loT Controller Configuration Guide for more information.
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Upgrading the Software

o Upgrading the AP Firmware Using SmartZone 100 or Virtual SmartZone Controller.........cccuieiviiiiiiieiiiieeiiee e 57
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e  Upgrading the Ruckus loT Controller with N+1 Configuration

Upgrading the AP Firmware Using SmartZone 100 or
Virtual SmartZone Controller

You can upgrade the existing AP firmware using a SmartZone 100 controller or Virtual SmartZone.

Always back up the controller before attempting a software upgrade. If you are managing a multi-node cluster, back up the entire cluster, and then
verify that the backup process has completed successfully. If you have an FTP server, back up the entire cluster and upload the backup files from all

the nodes in a cluster to a remote FTP server.

NOTE
Ruckus strongly recommends backing up the SmartZone 100 controller cluster before performing an upgrade. If the upgrade process fails

for any reason, you can use the latest backup file to restore the controller cluster.

NOTE
Before beginning the upgrade, you must obtain a valid controller software upgrade file from Ruckus Support or an authorized Ruckus

reseller.

1. Copy the software upgrade file that you received from Ruckus to the computer where you are accessing the controller web interface or to

any location on the network that is accessible from the web interface.
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2.

From the SmartZone 100 user interface, click Administration > Upgrade.
FIGURE 52 SmartZone 100 User Interface

T RUCKUS‘ VRIOTOA-CLST 0, _ ! >
s = e iy e e Filter default ™ = o

Upgrade | Upgrads History | AP Paich

Current System Information

Upload

[¥] Run Pre-Upgrade Validations (It will take a few minutes to check if the system has sufficlent resources to complete the upgrade)
Upload the patch file {* xime] that you want to use to upgrade the contraller
Browse

Patch for Pending Upgrade

Select the Upgrade tab.

Under Current System Information, the controller version information is displayed.

NOTE
The Upgrade History tab displays information about previous cluster upgrades.

Under Upload, select Run Pre-Upgrade Validations to verify if the data migration was successful. This option allows you to verify data
migration errors before performing the upgrade.

NOTE
You can still upgrade even if there are data migration errors.

Click Browse to select the .ximg patch file.
Click Upload to upload the controller configuration to the configuration in the patch file.

The controller uploads the file to its database, and then performs file verification. After the file is verified, the Patch for Pending Upgrade
section is populated with information about the upgrade file. If data migration was unsuccessful, the following error is displayed:

Exception occurred during the validation of data migration. Please apply the system

configuration backup and contact system administrator.
If the controller configuration upload was successful, perform one of the following steps:
e  Click Upgrade to start the upgrade process without backing up the current controller cluster or its system configuration.

e  Click Backup & Upgrade to back up the controller cluster and system configuration before performing the upgrade.

When the upgrade (or backup-and-upgrade) process is complete, the controller logs you out of the web interface automatically. When the
controller login page displays again, you have completed upgrading the controller.
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8. From the Smartzone 100 user interface, click Access Points.
9. Select the zone from the list, click More, and select Change AP Firmware from the list. The Change AP Firmware dialog box is displayed.
The current AP firmware version is displayed.

FIGURE 53 Changing the AP Firmware
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10. Click Upgrade to upgrade to the new firmware version.

FIGURE 54 Upgrading to New Firmware

If you upgrade to a new firmware, a backup
configuration file will be created. You can use this
backup file to downgrade to original firmware (if
needed).

B O
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11. Click Yes. A confirmation message is displayed stating that the firmware version was updated successfully.

FIGURE 55 Update Successful Confirmation Message

X

AP firmware updated successfully.

12. Click OK.

13. Open the Ruckus loT Controller. From the Admin tab, click Versions and Patches.

FIGURE 56 Uploading an Image

Admin
Services . ;
|‘ Upload Image \ Change Version to : Select - Set;}
Plugins ——,
\ Upload Patch |
\. J
Account
Patch list
VM Configurations Patch lis
Ho Patch Available
DB Backup
Reset & Rebont

14. Click Upload Image and select the tar.gz image.

15. From the Change Version to list, select the image, and click Set.

The Ruckus IoT Controller is upgraded successfully to the new build.
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Upgrading the Ruckus loT Controller

Previous versions of Ruckus loT Controller supported a hard disk size of 8 GB. To use the latest version of Ruckus loT Controller, the hard disk size
must be increased from 8 GB to 20 GB. After the hard disk size is increased, you can upgrade the Ruckus IoT Controller software.

Complete the following steps to upgrade the Ruckus loT Controller software.

1. From the main menu, click Admin .

FIGURE 57 Upgrading Ruckus loT Controller

Admin
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Plugins
Upload Patch

Upload Image

Account

VM Configurations

Version list Patch list
Versions & Patches
1.5.0.0.34 No Patch Available
DB Backup
License
Settings

Reset & Reboot

2. Inthe left navigation pane, click Versions & Patches.
3. Click Upload image and select the tar.gz image file.

4. Inthe Version list, click Set.

The Ruckus loT Controller is upgraded to a newer version.

Upgrading the Ruckus loT Controller with N+1
Configuration

To upgrade the master and slave Ruckus 10T Controller with N+1 Configuration, perform the following steps.

1. Upgrade the SmartZone to the supported version.

NOTE
Refer to Upgrading the AP Firmware Using SmartZone 100 or Virtual SmartZone Controller on page 57 for more information.

2. Disable the N+1 configuration if previously configured.

NOTE
Refer to "Disabling the N+1 Feature" in the Ruckus loT Controller Configuration Guide.
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3.  Upgrade AP Firmware using SmartZone 100 or Virtual SmartZone Controller.

NOTE
Refer to Upgrading the AP Firmware Using SmartZone 100 or Virtual SmartZone Controller on page 57 for more information.

4. Upgrade the Ruckus loT Controller software.

NOTE
Refer to Upgrading the Ruckus loT Controller on page 61 for more information.

5. Upload the licenses to the controllers.
Refer to Activating a License on page 67 for more information.

6. Re-configure the N+1 feature.

Refer to "Configuring the N+1 feature" in the Ruckus loT Controller Configuration Guide for more information.
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Hot Upgrade of loT Gateway

The Hot Upgrade of loT Gateway supports offline upgrade of AP IoT Bundle from IoT Controller. If the controller is running in a current loT image,

then the system makes sure the APs loT version is upgraded/downgraded to the current system image. If there is any IoT version mismatch in the AP
and controller, then a warning message is displayed in the IoT AP page.

To perform the offline upgrade follow the below steps.
1. From the main menu, click loT APs tab.

The loT Access Points page is displayed.
2. Clickan loT AP.

NOTE

If there is any mismatch in the IoT version of AP and controller then the following warning message is displayed, " Gateway loT
firmare mismatch".

FIGURE 58 Viewing loT APs
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3. To know more about the warning, click Events tab.

FIGURE 59 Displaying Events
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Connecting a Set of l1oT APs Using Grouping Method

There are two methods to determine the set of IoT APs to connect with the loT Controller.

1. Isolate the IoT APs and non-loT APs at Layer 2 (VLAN) or Layer3 (IP) subnets. In this case, DHCP Option 43 Sub-Option 21 can be
configured for networks with APs meant to connect with a particular loT Controller. Syntax of Sub-Option 21 is the same as with Sub-
Option 6 for WiFi Controller.

2. If network topology cannot be used for grouping, e.g., as a result of customer’s network topology policies, the second method to use is
static configuration method:
e  Disable IOT process on all APs.
e  Enable loT process only on loT Enabled APs.
e  Set their loT Controller IP address
This can be done through vSZ AP CLI Script. For example, in vSZ we create a zone for the group of loT enabled APs which we need to connect with a

particular loT Controller. Then we apply a vSZ AP CLI script to that zone which enables IoT (set iotg-enable 1) and sets the IoT Controller IP address
with the AP CLI command (set iotg-mqtt-brokerip <IP>).
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Activating a License

Ruckus IoT Controller is a licensed product. After purchasing Ruckus loT Controller, an email message is sent to you containing an activation code.
Clicking the activation code directs you to the Ruckus Support website. After the code is validated and attached to a device (the loT Controller serial
number), the license can be downloaded from the website.

Complete the following steps to activate the license.

NOTE
In the N+1 setup ensure that individual licenses are installed on both master and slave respectively.

1. Click the activation code in the activation email message. You are redirected to the Ruckus Support website support.ruckuswireless.com.

Log in to the website using your credentials.

2. Click Activate Purchase. The Activating Your Support Contact & License Code page is displayed. In the Code field, enter your activation

code, and click Validate.

FIGURE 60 Validating the License Code
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3.  After the successful validation of the license code, accept the Terms and Conditions, and click Activate Purchase.

FIGURE 61 Activating Your Support Contract and License Code
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4. Obtain the Ruckus loT Controller serial number in one of the two ways.
e Obtain the Ruckus loT Controller serial number using the Ruckus loT Controller console.
a. Logintothe console of Ruckus loT Controller.

b. Inthe Ruckus loT Controller Main Menu, enter 2 in the Enter Choice field to get the system details.

FIGURE 62 Ruckus loT Controller Main Menu

e To obtain the Ruckus loT Controller serial number using the Ruckus IoT Controller user interface, refer the topic " Uploading Ruckus
loT Controller License" in the Ruckus loT Controller Configuration guide.
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5. On the Associating Your License With Your Product page, enter the Ruckus loT Controller serial number, and click Validate Serial Number

to activate the license.

FIGURE 63 Associating the License with the Product
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After successful validation, the registration page is displayed.
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6. Select the PO1-INT1-WWOO device model number and click Register Device & Bind To Right To Use.

FIGURE 64 Registering the Device
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Your license information is displayed.
FIGURE 65 License Information
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7. Return to the Ruckus Support website support.ruckuswireless.com, and click LIMAN.

FIGURE 66 Accessing Smart License Manager (LIMAN)
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8. Inthe Smart License Manager (LIMAN) page, enter the serial number of the controller, and click the Download Licenses button.

NOTE
The license must be uploaded to the controller.

FIGURE 67 Downloading the License
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